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Guide Description

The purpose of this guide is to lay out the steps for deployment the OS upgrade from the M365 skus
across your network. This guide is assuming you have the M365 Business, M365 E3, or M365 E5 License.
After the you complete this guide you will have:

Run an assessment for Windows 10 Upgrade Readiness for all the devices on your network
Created Windows 10 Installation Media

Downloaded and Configured MDT and WDS to deploy the Windows 10 Upgrade

Tested the upgrade on 2 pilot devices

e Configured WDS and MDT for Light Touch Installation (LTI) to all users on your network

**Disclaimer**

This guide is meant to provide best practices for Windows 10 Upgrade readiness and broad
deployment across your network. It is meant to be used as a template, but the settings configured
will not be the same in all use cases. You must access all the devices in your network to decide how
many different versions of the WIM file you need to create to match the compatibility of the
workstation. As a best practice, test all configurations with a pilot group before moving to broad
deployment across an entire organization
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Checklist

Baseline System Access to Apps you want 2 Pilot Devices

Requirements Primary DC to deploy to Test

a. Have Local Admin ID on all Workstations
i.  We need this when running the Microsoft Assessment and Planning toolkit
ii. Workstations must be turned on for this tool to run an assessment on that
device
b. Baseline System Requirements on Sever:
i. Microsoft Deployment Toolkit:
1. Supported Operating System

a. Windows 10, Windows 7, Windows 8, Windows 8.1, Windows
Server 2008 R2, Windows Server 2012, Windows Server 2012
R2, Windows Server 2016, Windows Server 2019

2. Other Requirements

a. The Windows ADK for Windows 10, version 1809 or later, is
required for all deployment scenarios.

b. Configuration Manager, version 1810 or later, is required for
zero-touch installation (ZTl) and user-driven installation (UDI)
scenarios.

¢. Access to Primary DC
i. This is where we will be spending most of our time during setup
ii. This is where we will run and install the following
1. Microsoft Assessment and planning toolkit
2. MDT
3. WDS
d. Apps you want to Deploy
i. Part of the configuration for MDT allows us to add applications to our
deployment. | do not cover that in this guide but can be helpful if you want to
push out any on-premise applications. | recommend using Intune for this
feature.
e. Choose 2 pilot devices you want to enroll into Intune
i. These devices we will be using to test our deployment share and configure our
bootstrap.ini file so the broad audience has a LTI (Lite touch installation)
experience
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Install the Microsoft Assessment and Planning Toolkit

We want to perform an assessment on the computers in our network to make sure they are compatible
for the Windows Upgrade. The Microsoft assessment and planning toolkit allows us to scan all the
computers in our Active Directory or by scanning a certain IP range and tells us which devices are ready
for the upgrade.

1. Go to the following link on your AD server and download the Microsoft Assessment and
Planning Toolkit: https://www.microsoft.com/en-us/download/details.aspx?id=7826

& Microsoft Assessment and Planning Toolkit — X

i Welcome to the Setup Wizard for Microsoft Assessment and
Planning Toolkit.

The wizard will configure this product on your computer. Click Next to continue or
Cancel to exit the wizard.

T

2. Run through the wizard to install:

& Microsoft Assessment and Planning Toolkit — X

Please wait for the wizard to finish configuring Microsoft Assessment and Planning Toolkit.

Status:



https://www.microsoft.com/en-us/download/details.aspx?id=7826

3. Go to start and open the program:

v 050 2 e d

n Microsoft Assessment and Plannin...

A

(, Google Chrome

Microsoft User Experience Virtuali...

Expand ~

Most used

Deployment Workbench

L
g Snipping Tool

e Internet Explorer
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> >

Windows

Windows
Server Manager  PowerShell PowerShell ISE

g ¢H

Windows

Administrativ... Task Manager Control Panel

= § m

Remote

4. Click Desktop, then collect inventory data under Windows 10 Readiness

& Microsoft Assessment and Planning Toolkit

File View Tools Help

(

€ > - [\ v Desktop »
Overview

Cloud /
Desktop

Server

Desktop Virtualization
Server Virtualization
Database

Usage Tracking

Crnranmant

&l Desktop

Steps to complete
£ Collect inventory data

Scenarios

T . .
M Windows 10 Readiness L]

This scenario is unavailable until you do the ]
following: i
Collect inventory data
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5. Choose Windows Computers and click next:

Lok

| & Inventory and Assessment Wizard X

1'3 Inventory Scenaric

The MAP Toolkit helps you to collect information for
) several different inventory scenarios. The scenarios you
- Discovery Methods  choose determine the technologies used to collect

5 Active Directory information from computers in your environment.

Credentials b
Choose your scenario.

)| Active Directory

Options ! L
| All Computers [ JLirwUNIX cornputers
Credentials [ ]VMware computers
[ ] Active Devices and Users hd
Credentials Order
Summary Description

This inventory scenario uses WMI to collect hardware, device,
and software information about Windows-based computers in
your environment, including Microsoft Office, SQL Server, Sha

Collector Technologies: WML

< Previous Finish

6. Choose you methods:

'3 Discovery Methods

Id Inventory Scenarios ~ Select which methods to use to discover computers.

— Use Active Directory Domain Services (AD DS)

Active Directory D Use Windows networking protocols

Credentials
S{ Active Directory [ ] Use System Center Configuration Manager (SCCM)
W Options
+| Gcan an IP address range
-1 Scan an IP Address &
“ Range

[ ] Manually enter computer names and credentials

All Computers
Credentials [ ] Import computer names from a file

Credentials Order

Summary b
‘ Select this checkbox to import computer

| < Previous || Next > | Finish

[




7. [If using AD DS, enter necessary info:

' & Inventory and Assessment Wizard X

" % Active Directory Credentials

c

54

M

Inventory Scenarios ~ Specify the logon information used to connect to the
Active Directory forest and discover domain-joined com

Discovery Methods (* Indicates reauired field

_ Qornain* : wraj rec{}rds-cﬂm i
: smicrosoft.com o

Active Directory

Options Domain account*: wrajrecords\nross
| - user@doma

¢ Scan an IP Address

Range This account does not require administre

All Computers Password*: “ |
Credentials -

Credentials Order

Summary

< Previous || Next > || Einish | | gancel[\hg !

T

8. [If using IPs, enter range:

& Inventory and Assessment Wizard X

o

j’i Scan an IP Address Range

Inventory Scenarios  Spedify the IP address ranges to scan for computers and
devices.
Discovery Methods

- Enter the IP address ranges below. Press Tab to insert a new
TOW.

All CDmPuters IP addresses between the starting and ending values will be
Credentials included. A maximum of 100,000 addresses are allowed.
Credentials Order
IP address ranges:
Summary
Starting Address Ending Address

< Previous || Next > || Finish || Cancel |
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9. Ensure you add an administrator account with local admin access to all computers

Inventory and Assessment Wizard

ers Credentials

Please supply account credentials for the platforms and technok you've ch
These credentials will be used to connect to the machines you've specified.

&
crevon | [ot> ] o[ o

10. Finish the wizard till completion

% Inventory and Assessment Wizard % X

Inventory Scenarios ~ Your selections are summarized below, including any
N detected errors.
,| Discovery Methods

' Scan an IP Address  Review your selections and resolve any detected errors before
starting the inventory. [

4 Range
All Computers =-Errors A(
Credentials . “-The WMI collector technology requires at least one All Compt

1§ Credentials Order (= Summary =

| £} Inventory Scenarios
_ - Windows computers
.. Selected Collector Technologies: WMI
| Discovery Methods
- Active Directory Domain Services: Not Selected
Windows Networking protocols: Not Selected
-~ SCCM Server and Credentials: Not Selected
[1IP Address Ranges

©10.1.1.1 - 10.1.1.50
= All Comrninters Credentiale

< Previous || Next > || Finish H Cancel |
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11. After the assessment runs, you will get an excel sheet with a summary:

a.

ard . Font Angnment

Al v f. Windows 10 Assessment Summary for Client Computers

A B

1 [WIndows 10 Assessmeni Summary for Client Computers
This worksheet provides a summary of Windows 10 readiness information for computers that are already runnin,

client operating system.

BN Windows 10 Readiness . Before Hardware Upgrades - After Hardware Upgrades
Meets Minimum System 70 232
Requirements

6 Not Ready for Windows 10 162 0
Insufficient Data (Not 31 31

Inventoried)

Insufficient data typically means that the computer was turned off or that there were not
sufficient permissions on that device with the credentials provided

Client Assessment tab shows a list of the devices in a more detailed view:

| IWIndows 10 Assessmenl Summary for Client Computers
This worksheet provides a summary of Windows 10 readiness information for computers that are a

client operating system.

Meets Minimum System 70 232
Requirements
Not Ready for Windows 10 162
Insufficient Data (Not 31 31

! Invgn!orlegl

¥

’ Summary AssessmentValues ClientAssessment AfterUpgrades DeviceSur
e ———————
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c. AfterUpgrades shows what you need to do to upgrade:

Windows 10 Minimum Ready Computers After Hardware Upgrades
This worksheet describes computers that are not currently able to run Windows 10 and the hardware upgrades requil

the minimum system requirements for Windows 10.

Computer Name - IP Address - Memory
Map-7- 10.217.74.28;fe80::4836:516¢:1d5¢: | Intel(R) Xeon(R) CPU L5630 |Upgradeto:
x64.map.test. CONTOSO.COM 3635;200!:6898@:323(!:4836:51& @ 2.13GHz, 64 bit

:1d5c:36a5
Map-81- 172.16.0.218;fe80::3435:8373:4caa: | Intel(R) Xeon(R) CPU L5630 (Upgradeto:
multi.map.test. CONTOSO.COM €948 @ 2.13GHz, 64 bit

10.217.72.227;fe80::3409:a€00:9be
:19b¢;2001:4898:€0:323d:d85d:5f6

7:1593:a55b;2001:4898:€0:323d:79

c4:3acf:7e0d:3d22;2001:4898:0:

MAP-81- 10.217.72.236;fe80::e592:bb87:ea |Intel(R) Xeon(R) CPU L5630 |Upgradetoi
x64.map.test. CONTOSO.COM 2:0008;2001:4898:€0:323d:f1a9:1 |@ 2.13GHz, 64 bit
d7c:d1fd:ccd7;2001:4898:€0:323d:
9058:13cf:eb19:9821;2001:4898:¢0

DY
Map-81-x64- 10.217.74.29;fe80::7012:3€67:b913 | Intel(R) Xeor CcPU L5630 |Upgradeto:
cn.map.test.CONTOSO.COM :4393;2001:4898:0:323d:d0bd:8d0| @ 2.13GH. bit

B L e )

» Summary Asses

Client

AfterUpgrades Dev

Install the Windows 10 Installation Media

1. Login to your admin center and scroll down to the Windows 10 Card on your Dashboard. Here
you can click on a link to download the installation media. **NOTE** you will want to install
this on your AD server:

Microsoft 365 admin center Q & 7 NR

Eo Device Management [y & Azure Active Directory [=y {3 Support

o]
2 Get started & Customize sign in + New service request

R @3 Set up device enrollment 53 Enable password reset F=  View service requests

= -+ Configure device profiles ©: Add an application
-+ Create app policies

!E . o g . 1 ] .
[ Device policies = Device actions > am Windows 10 Upgrade

= I
-+ Add policy —+ Deploy Windows with AutoPilot 4 Install upgrade 5

0 & Edit policy & Remove company data =7 Share the download link
il Delete policy (O Factory reset 1 Create installation media

@ ] Manage Office deployment @ Troubleshaoot installation

N S

Train yourself By Message center >

AD
e — @ Need help? [ Feedback
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https://www.microsoft.com/en-us/software-download/windows10

Download Windows 10

Windows 10 October 2018 Update now available

The Update Assistant can help you update to the latest version of Windows 10. To get started, click Update now.

Create Windows 10 installation media

To get started, you will first need to have a license to install Windows 10. You can then download and run the
media creation tool. For more information on how to use the tool, see the instructions below.

Download tool now

Privacy

2. Click on Download tool now to launch the Wizard. You will want to run this wizard for upgrades
either on the existing computer or to create the ISO file to upgrade other computers. First Agree
to the terms and conditions:

£ Windows 10 Setup — X

Applicable notices and license terms

to.

‘MICROSOFI' SOFTWARE LICENSE TERMS

MICROSOFT MEDIA CREATION TOOL

IF YOU LIVE IN (OR ARE A BUSINESS WITH A PRINCIPAL PLACE OF BUSINESS IN) THE
UNITED STATES, PLEASE READ THE "BINDING ARBITRATION AND CLASS ACTION
WAIVER” SECTION BELOW. IT AFFECTS HOW DISPUTES ARE RESOLVED.

These license terms are an agreement between you and Microsoft Corporation (or one of its
affiliates). They apply to the software named above and any Microsoft services or software updates
(except to the extent such services or updates are accompanied by new or additional terms, in which
case those different terms apply prospectively and do net alter your or Microsoft's rights relating to
pre-updated software or services). IF YOU COMPLY WITH THESE LICENSE TERMS, YOU HAVE THE
RIGHTS BELOW. BY USING THE SOFTWARE, YOU ACCEPT THESE TERMS.

1. INSTALLATION AND USE RIGHTS.
a) General. You may install and use one copy of the software to develop and test your

applications, and solely for use ‘n Windows. You may make one backup copy of the
software for the sole purpose or'reinstalling the software.

7
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3. Inthis guide, we are going to create the installation media:

£ Windows 10 Setup - X

What do you want to do?

O Upgrade this PC now
@ Create installation media (USB flash drive, DVD, or ISO file) for another PC

4. Forthe “Upgrade this PC Now” option, please watch this short video:
https://www.microsoft.com/en-us/videoplayer/embed/RE201WL

5. Chose 32-bit or both:

i Windows 10 Setup — X

Plea: ntir

Select language, architecture, and edition

Language English (United States) v

Ediion
Architecture 64-bit (x64) -

32-bit (x86
64-bit (x64)
Both
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6. Choose which media to use, we will be downloading the ISO file:

£ Windows 10 Setup X

Choose which media to use

nt tition,

O USB flash drive
It

@ SO file

7. Select your destination to save the ISO:
\

=

£ Select a path

&« v « Desktop > Windows 10 1SO v 0

Organize ~ New folder ==
= Pictures 2 Name
BitTitan Migratio
. No items match your search
Camtasia ;
Microsoft Teams
7 OneDrive - PAX8
@ OneDrive - PAX8

f PAXs

Sales Engineers -

=4 This PC
v <

File name: | Windows 10 Pro I1SO

Save as type: |1SO File (*.iso)

 Hide Folders Cancel




T-rms

8. Allow the download to complete, click Finish when done:

& Windows 10 Setup - X

Downloading Windows 10

Feel

Progress: 1%

9. You will now have the ISO download to burn to a DVD:

= | Windows 10 1SO

“ Home share

o - 4 + This PC » Desktop » Windows 10 1SO

# Quick access
m Desktop Windows 10 Pro 1SO
& Downloads
Documents
= Pictures
BitTitan Migrations
Camtasia
Microsoft Teams Ch

& OneDrive - PAX8
@ OneDrive - PAXS

fi Paxs

Sales Engineers - Sa
% This PC

& Network

1item
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Install WDS and MDT

Windows Deployment Services enables you to deploy the Windows Operating system over your
network. It can also listen for PXE boot request. The Microsoft Deployment toolkit (MDT) allows us to
create custom WIM files in a deployment share. We will be putting WIM files that we create with MDT
into the boot images section of WDS so that computers are immediately prompted to upgrade when the
boot their device.

1. Install WDS
a. Addroles and features
Server Manager * Dashboard @1 anag

_ WELCOME TO SERVER MANAGER

o Configure this local server

ige Services >

QUICK START

2 Addroles and fdmtures

3 Add other servers to manage

WHAT'S NEW
4 Create a server group

5 Connect this server to cloud services

b. Role Based Assignment

=, Add Roles and Features Wizard — Od K

DESTINATION SERVER

Select installation type MDTlesting

Before You Begin Select the installation type. You can install roles and features on a running physical computer or virtual

machine, or on an offline virtual hard disk (VHD).
Installation Type

(® Role-based or feature-based installation
Server Selection ) . ) .
Configure a single server by adding roles, role services, and features.

(O Remote Desktop Services i ion

Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.

< Previous ‘ | Next > Install Cancel




c. Choose what server | want to install on
d. Choose Windows Deployment Services

Select one or more roles to install on the selected server.

Roles

O

0 1 o

Active Directory Lightweight Directory Services
Active Directory Rights Management Services
Device Health Attestation

DHCP Server

DNS Server

Fax Server

File and Storage Services (1 of 12 installed)
Host Guardian Service

Hyper-V

MultiPoint Services

Network Controller

Network Policy and Access Services

Print and Document Services

Remote Access

intows Deployment Service

d

Windows Server Essentials Experience
Windows Server Update Services

Desc

Winc
prov
of ra
Winc
comy

e. Click Add Features>Next>Next>Next>Next>Install
f.  Wait for installation to complete:

r-Minus &

Add Roles and Features Wizard

Installation progress

View installation progress /

o Feature installation

Installation succeeded on MDTTesting

- O X

DESTINATION SERVER
MDTTesting %

Remote Server Administration Tools
Role Administration Tools

Windows Deployment Services

Deployment Server
RE‘SUP& Transport Server

Windows Deployment Services Tools

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

< Previous

Next >

Close Cancel
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2. Goto Tools>Windows Deployment Services

T Server Manager - ] b4

@ v Server Manager » WDS - @ | f’1 Manage Tools  View  Help
Component Services
B=  SERVERS Computer Management
iE Dashboard B0 i servers 1ot Defragment and Optimize Drives
i Local Server Flrce o @~ @ Disk Cleanup
B Al servers Event Viewer
g File and Storage Services b Server Name | IPv4 Address Manageability Last Update Wir S nator

L MDTTesting  10.0.29.5 Online - Performance counters not started 4/4/2019 6:48:13 PM 003 Microsoft Azure Services

ODBC Data Sources (32-bit)
ODBC Data Sources (64-bit)

Performance Monitor

Print Management
Resource Monitor
Services

System Configuration
System Information

EVENTS Task Scheduler

All events | 0 tota i
| events | O total “l Windows Deoloyment Services

Windows Firéwall with Advanced Sec
Windows Memory Diagnostic
Windows PowerShell

3. Right click on Server>Configure Server

f Windows Deployment Services
File Action View Help
&= |H &

8 Windows Deployment Services Windows Deployment Services

v 33 Servers
=i, MDTTestina . .
L Act ﬁgnﬁgure Server ' Windows Deployment Services

Remove Server

Windows Deployment Services enables you to deploy Windo
Refresh
This Microsoft Management Console (MMC) snap-in enables
Help Services. You can perform tasks including adding images, cor
properties. You can also manage your server using the WDSU

To manage a server from this snap-in, you must add it first. Ti
Add Server.




4. Integrate with AD

Services Windows Denlovment Services

! Windows Deployment Services Configuration Wizard x

& Install Options

Select one of the following options:
@®integrated with Active Directory;
This server is a member of an Active Directory Domain Services (AD DS) domain,
or a domain controller for an AD DS domain.

(O Standalone server

Configure the server so that it is standalone, operating independently of Active
Directory.

. <Back | Ne> | | Cancel
5. Configure the following:
rvices Windows Denlovment Services
! Windows Deployment Services Configuration Wizard X[

PXE Server Initial Settings

You can use these settings to define which client computers this server will respond to. Known clients are
the clients that have been prestaged. When the physical computer perfforms a PXE boot, the operating
system will be installed based on the settings that you have defined.

Select one of the following options:
(O Do not respond to any client computers
(O Respond only to known client computers
(® Respond to all client computers (known and unknown)
{Require administrator approval for unknown computers. When you select this option, you must

E]mpmve computers using the Pending Devices node in the snap-in. Approved computers will be
iadded t list of prestaged clients.

To configure this server, click Next.

<Back [ Net> | | Cancel |
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6. You should see the following:

File Action View Help
e nmcz Bm

! Windows Deployment Services w2012r2dep.deploy.com
4 {3 Servers ==
4 :m&zaepdepbym 2 Instal |
- Install Images A ,
b @& Bootk . Boot Images
9 (15 Pending Devices

b 5 Pending Devices
b 3 Multicast Transmissions
b 4 Drivers

b & Active Directory Prestaged Devices

"3} Multicast Transmissions
4 Drivers

7. Make sure the service starts correctly:

File Action View Help
o 2m as B

§ Windows Deployment Services

4 33 Servers ‘ i
4| o w2012r2deg -~ : :
b Install It Properties . 9
p & Bootim Remove Server _""95,
b 8 Pending ™y Tacks ,
b 3% Multica o
b 4 Drivers View » op
b _m Active Director Refresh Restart
Export List...
Help

o Successfully started Windows Deployment Services.
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Install MDT: https://www.microsoft.com/en-us/download/confirmation.aspx?id=54259 and
WADK: https://docs.microsoft.com/en-us/windows-hardware/get-started/adk-install

a. Download the Windows ADK for Windows 10, version 1809

b. Download the Windows PE add-on for the ADK
Run through Wizard

a. Configure the following for WADK:

@Wirldrm'. Assessment and Deployment £l - Windoes 10 - s

Select the features you want to install

Click a feature name for more information.

[] Agglication Compatibility Tocls User State Migration Tool (USMT)

[¥] beployment 1ooks Size: B12.7 MB

'7"'1'59"'!; And Configuration Designer (1CL) lestals B emiiggrale wser olala Trom a presicous installation of
[F] Conlhepuation Desigues Windows o a new installation.

Inchedes:

[+ wohurmiz Activation Kanagestient Toal WAAKT] . CanElale luol
[+ Wirkdorees Performance Toolkit * LpadState too

. * LISMTUtls tao
[+f] Mierasoft Uses Experiance Virtualization (UE-V] Template

] Weadia aXpedence Analyzar

L+

Estimated disk space required: 1.0 GB
Disk space available: 116.0 GB
| Back Install Cancel |

b. Search for Deployment Workbench under the start menu to make sure everything
installed correctly:

- . (B =]
Volume Activation Management T... i =

Windows
Windows Imaging and Configurati... Administrativ... Task Manager Control Panel

Windows System Image Manager

Deployment and Imaging Tools En... ad 'E‘ I - I

Remote
UDI Wizard Designer Desktop... Event Viewer File Explorer

A

Deployment Workbench

Customer Feedback Options

Configure ConfigMgr Integration


https://www.microsoft.com/en-us/download/confirmation.aspx?id=54259
https://docs.microsoft.com/en-us/windows-hardware/get-started/adk-install
https://go.microsoft.com/fwlink/?linkid=2026036
https://go.microsoft.com/fwlink/?linkid=2022233

10. For the Windows PE installation wizard, specify Installation on this computer:

ﬁ Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons - Windows 10 — X

Specify Location

® Install the Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons -
Windows 10 to this computer

Install Path:

C:\Program Files (x86)\Windows Kits\10\ Browse...
* Windows Kit common installation path used

O Download the Windows Assessment and Deployment Kit Windows Preinstallation Environment Add-ons -
Windows 10 for installation on a separate computer

Download Path:

C:\Users\nross\Downloads\Windows Kits\10\ADKWinPEAddons Browse...
Estimated disk space required: 5.7 GB
Disk space available: 1044 GB

Next ‘ l Cancel

11. Create new Deployment Share

a.

In Deployment workbench>New Deployment share

a DeploymentWorkbench - [Deployment Workbench]
File Action View Help

= H

‘Tf1 Deployment Workbench

L2} Information Center
» LA Deployment €-----

Deployment Share osoft Deplo’
Opéh Deployment Share
licrosoft Deployi

Refresh nce for automat
tandardizing des
Help juration manage

MDT supports deployi

emhedded nneratinn

T-

INUS
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b. Customize the following settings to your environment:

Meswe Deployrment Shane Wizard i
- g’ Share

Share

Specify the share name to be used with the speciied local path. i the share already exists on this
computer, it must point to the path specified for this deployment share.

Share name:
D e

Full path UNC path:  \\MDT Testing\Deployment Share$

§§§?§|¢

MNew Deployment Share Wizard

9‘ Descriptive Name

Specify a descriptive name for the deployment share.

Deployment share description:

Provous | [ Nea ]| Cancs
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New Deployment Share Wizard ;

When performing deployments, the behavior of the Deployment Wizard can be customized by tuming
varous wizard panes on or off. For those that are not desired, modify the defaults below as appropriate.
[4] Ask f a computer backup should be peformed.

[ Ask for a product key.

[J Ask to set the local Administrator password.

[4 Ask f an image should be captured.

[4 Ask # BitLocker should be enabled.

[

These settings can be changed later by modifying the rules defined for the deployment share.

New Deployment Share Wizard X

-

Path All of the necessary details have been specffied. Please review the values below.
Share
Descriptive Name Details:

Path: D:\DeploymentShare

Upgrade: False

ShareName: Deployment Share$

Description: MDT Deployment Share

Ask about Backup: True

Ask for Product Key: False
Ask for Admin Password: ==
Ask about Image Capture: True
Ask about BtLocker: True

Click next to execute the requested action.

s




C.
settings to other customers:

New Deployment Share Wizard

9 Confirmation

0 The process completed successfully.

share  with path D:\D

Share created

Perfoming the operation “New drive: on target “Name: DS001 Provider: MicrosoftDeployment Tookct \MI
“deployment share’

D

|Adding MDT drive DS001 to the persisted
Successfully added MDT dive DS001 tompaned drve st

s
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Click View Script to get a custom powershell script you can use to implement the same

File Action View Help

- = T NewDP - Notepad
T Deplo e £t Format View Help

> "51‘" MNew-Item -Path "D: \Oeploymentshare"
New-SmbShare -Name "DeploymentShares"

-ItemType directory
-Path "D:\DeploymentShare" -FullAccess Administrators
Import-Module “C: \Program Files\Microsoft Deployment Toolkit\bin\MicrosoftDeploymentToolkit.psd1l"
new-PSDrive -Name "DS@@1" -PSProvider "MDTProvider" -Root "D:\DeploymentShare" -Description "MDT Deployment Share™
-NetworkPath “\\MDTTesting\DeploymentShare$" -Verbose | add-MDTPersistentDrive -Verbose

d. You will now see the following:
e o OEd | =] el

ﬁ Deployment Workbench
> .4 Information Center
v A Deployment Shares

[ Applications

Il Operating Systems

m Out-of-Box Drivers

| Packages

_) Task Sequences

[] Advanced Configuration
[a Monitoring

v [ MDT Deployment Share (D:\DeploymentS|

Name

¢4 MDT Deployment Share (D:\De...
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Import Your OS

1. Add your OS to the Deployment Workbench

a. Go to File Explorer and create a new Folder in your D: drive called Win10Source
| Drive Tools ~ Temporary Storage (D)
e Share View Manage
[ o » This PC » Temporary Storage (D) v U | Search Tempor:
Name Date modified Type
ess
, * DeploymentShare 4/4/2019 7:48 PM File folder
g * Win10source ’ 4/5/2019 7:13 PM File folder
ads
D DATALOSS_WARNING_README 4/3/2019 4:47 PM Text Docur
ants »
*
g N
b. Copy the files from the DVD drive from part one of this document and paste them into

this folder:

= | Drive Tools  DVD Drive (F;) ESD-ISO —

{ome Share View Manage
[ #4 > This PC » DVD Drive (F) ESD-ISO » v | Search DVD Drive (F)
~
Name Date modified Type
access
ktop * boot 3/12/2019 8:16 AM File folder
efi 3/12/2019 8:16 AM File folder
loads o+
sources 4/5/2019 6:55 PM File folder
t g
Hments support 3/12/2019 816 AM  File folder
res * 'ﬂ autorun 3/12/2019 8:09 AM Setup Informatic
ces A [ bootmgr 3/12/2019 8:09 AM File
’C D bootmgr.efi 3/12/2019 8:09 AM EFI File
ta setup 3/12/2019 8:09 AM Application
ktop
uments

nloads
iic

ares



| Import Operating System Wizard

QJ OS Type
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c. Right click on Operating Systems>Click Import Operating System

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)\Operating Systems]
File Action View Help

o9 x|z H
ﬁ Deployment Workbench Name Description
> L.} Information Center
~ [\ Deployment Shares There are no itemns to show in this view.

v [ MDT Deployment Share (D:\DeploymentS|
> [% Applications
R Operating Systame<
> [& Out-of-Box Dri Import Operating System n

> | Packages New Folder
5> L Task Sequence )
, [ Advanced Con View ?
> E] Monitoring Refresh
Export List...
Help

d. Choose Custom Image file and choose the boot.wim file we moved into the D: Drive:

x
Jpen X
™ « Winl0source > sources » v O Search sources P
Organize v New folder = @
Choose the type of operating system to add. - ~
%| Documents # Name Date modified Type
O Full set of source files —_
The operaling systeggbeing added corsists of souse fles from  Windows DVD, CD), or squivalert. &= Pictures  # dimanifests 4/5/20197:13PM  File folder
sources en-us 4/5/2019 7:13 PM File folder
@® Custom image fie B Th etwproviders 4/5/2019 7:13 PM File folder
Add a captured image (WIM fis) that you wish to deploy. £ This PC ) o
inf 4/5/2019 7:13 PM File folder
I Desktop o S
) migration 4/5/2019 713 PM File folder
O Windows Deployment Services mages | Documents B
Add the images avaiable on a specific Windows Deployment Services server. replacementmanifests File folder
* Downloads sKs File folder
D Music uup 20197:13PM  File folder
[&] Pictures vista |> 4/5/2019 7:13 PM File folder
I Videos xp 4/5/2019 7:13 PM File folder
. Wil 4/ 19 6:51 PM WIM Fil
i, Windows (C || boot.wim /5/2019 6:5 ile
== Temporary Stora < 5
File name: \ bootwim v| WIM (*.wim) v

==
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e. Set up files are not needed:

mport Operating System Wizard

? Selup

0S Type

Setup
'WDS Server
Destination

rg

Summary
Progress
Confirmation

Specify operating system setup files.

@ Setup files are not needed
Do ot copy any setup files

O Copy Windows 7, Windows Server 2008 R2. o later setup files from the specfied path

Speciy a directory containing the Windows 7, Windows Server 2008 R2. or ater setup files that
should be used to install this custom image. These fies should maich the version of Windows beng
installed, and are only needed f the files are not avaiable in another available 05

Setup source directory’
| Browss..

f. Continue till completion:

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)\Operating Systems]

File Action View Help

e 2= H

ﬁ Deployment Workbench
> [} Information Center
v [ Deployment Shares
v [ MDT Deployment Share (D:\DeploymentS|
> [% Applications
m Operating Systems
> m Out-of-Box Drivers
> Lk Packages
[ Task Sequences
> [ Advanced Configuration
> [y Menitoring

Name Description Platform Build
A Microsoft Windows PE (x64) in Upgrade Win 10 bo... Microsoft Windows PE (x64) x64 10.0.1
A Microsoft Windows Setup (x64) in Upgrade Win 10 ... Microsoft Windows Setup (x64) x64 10.0.1
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Create a New Task Sequence

1. Create a new task Sequence
a. Go to Task Sequence>New Task Sequence

@ Leploymentworknench - [Ueployment yworkpencnyLeployment Shares\MLUI Leployment Share (L:\Leployment

File Action View Help

9| 7|z H

?ﬁ Deployment Workbench Name D
> L2} Information Center

v [ Deployment Shares There are

v [ MDT Deployment Share (D:\DeploymentS|
> [ Applications
|1 Operating Systems
b m QOut-of-Box Drivers
> Lj Packages

> L) Task Sequer-~-

> [ Advanced ( New Task Sequence

> [j Monitoring New Folder >
View >
Refresh
Export List...
Help

b. Define the ID and Name:

New Task Sequence Wizard X
gl General Settings
Specify general information about this task sequence. The task sequence ID is used intemally as part of the
balaabss b deployment process. The task sequence name and are displayed by the depl 1t wizard.
Select Template
Select 05 S o
Spechy F Key Task sequence ID:
05 Settings Win10v1
Admin Password
Summary Task sequence name:
Progress |'Mndaws 10 Pro Upgrade|
Corfirmation
Task se]@ence cof

Previous Cancel




r-Minus &

c. Leave the following:

New Task Sequence Wizard

g’ General Settings

General Settings
Select Template
Select 0S

Specify Product Key
0S Settings

Admin Password
Summary

Confimation

Specify general information about this task sequence. The task sequence ID is used intemally as part of the
deployment process. The task sequence name and comments are displayed by the deployment wizard.

Task sequence ID:

Win10v1

Task sequence name:
|W‘|nduws 10 Pro Upgrade]

Task s&eﬂcﬂ comments:

Erevious | e

d. Choose the OS you added in the previous section:

The following operating system images are available to be deployed with this task sequence. Select
the one to use.

=-{A Operating Systems
el Microsoft Windows PE (x64) in Upgrade Win 10 boot wim

. Microsoft Windows Setup (x64)in Upgrade Win 10 boot wim




e.

f.

Do not specific a product key:

® Do ot speciy & product key at this time.

Aproduct key is not required when deploying Windows 7, Windows Server 2008 R2. or later 05
versions, or f the product key will be specfied at deploy time using the wizard or 8 nie.

) Specy a mutiple activation key (MAK key) for activating this cperating system.

In order to activate, sach computer deployed using this MAK key will need to contact the Microsolt
activation service on the intemet. This is only for Windows 7 and later opersting systems
when using volume icense media.

() Specy the product key for this operating system.
Specfy a retad product key. (Note that retal keys can only be used to activate 3 single machine )

Enter your custom settings:

New Task Sequence Wizard

? OS Settings

General Settings Specify settings about this task sequence. These settings will be used for all deployments of this task
sequence, unless ovemidden dunng the deployment process using the wizard or a rule.

Select Template
Select 0S
Speciy Product Key Full Name:
|Upgradewin10 |
Admin Password
i
Confimation
Intemet Explorer Home Page:
[ googe conl ]




g. Specify the admin password:

) Do not specky an Administrator password at this time.

The local Ad d wil be ded duning the deployment of this task sequence.sot s

ator
Mwumdhumm@ﬁm

[ Prevos || Net || Concel |

h. You will see your summary page:

D9 oo

General Settings
Select Template
Select 05

Specfy Product Key
0S Settings
Admin Password

Progress
Corfirmation

Al of the necessary detalls have been specified. Please review the values below.

Details:

Task SequencelD: Win10v1
TaskSequenceName: Windows 10 Pro Upgrade
IsUparade TS: False

Template: Custom xml

Click next to execute the requested action.




i. Click Finish to see the following:

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)\Task Sequences]

File Action View Help

L R INEY
T Deployment Workbench Name D
> L1 Information Center (] Windows 10 Pro Upgrade WIN1OVI

v [ Deployment Shares
v [ MDT Deployment Share (D:\DeploymentS|
» [ Applications
[l Operating Systems
> m Qut-of-Box Drivers
> L Packages
L} Task Sequences
» [ Advanced Configuration
> m Monitoring

T-MINUS

j. You can configure additional settings by right clicking on the task sequence and going to

properties:

General | Task Sequence | 0S info |

5K Add +| X Remove @ Up © Down | Properties | Options
Bevlioep | 2l e [Restat ]
Generd, » Run Command Line bt ]
Disks 4 Run PowerShell Script
Images » Set Task Sequence Vanable
Settings » Restart computer
Roles » Gather
T reomgoe .
() Enable BeLocker Install Updates Offline
) nject Drivers Vahdate
Aoply Patches I —
Next Phase Install Application
= g Postinetsl E Orch Runb
Copy Scripts ]
Configure 1
Inject Drivers |
Add Windows Recovery (WinRE) ‘
gNthuo
= 5 Sate Restore
) Gather local orly @
Post-Apply Ceanup
Recover From Doman
() Tattoo
& Opt Into CEIP and WER
& Windows Update (Pre-Application inst
£ nstal Applcations .
< D r ool et microsoh commdy

Ok || Comcel || ooy || Heo




1. Crete a Deployable Image:

Create MDT Deployable Image

T-MINUS

a. Right click on your deployment share and select Update Deployment Share

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)]

File Action View Help

<% 7= H

~ [ MDT Dep
> [ Applic
(4, Opera

» [E Out-o

> | Packa
L TaskS

> [ Advar

> [:'j Monit

ﬁ Deployment Workbench
» L.} Information Center
v [ Deployment Shares

Name

[% Applications
i Onerating Systems

Update Deployment Share »f-Box Drivers
Close Depb]ment Share 1ges
View 5 Sequences
nced Configuration
Refresh toring
Export List...
Properties
Help

b. Choose the following:

| Update Deployment Share Wizard

J’ gl Options

f

Summary
Progress
Confimation

‘When updating the deployment share, the latest tools will be copied to the deployment share. ¥ any changes
have been made to the boot image settings or to the content that needs to be included in the boot image,

those updates will also be made

I necessary, you can choose to completely regenerate the boot images, or to compress the existing boot

(® Qptimize the boot image updating process.

[[] Compress the boot image contents to recover space used by removed or modfied content.

(O Completely regenerate the boot images

Cancel




T- |Nus@

c. Complete till wizard completion:

i
| g’ Progress

0 Mourting WIM fie

| Summary
e =

=== Making sure the deployment share has the latest x86 tools ===
=== Processing Lite TouchPE x86) boot image ===
Buiding requested boot mage profile

Determining # any changes have been made in the boot image configuration
No exssting boot image profile found for platform x86 $0 a new image wil be created

hashes for requested contert
IChanges have been made. mage wil be updated
'Windows PE WIMC )\ Fles (B6)\Windows Kits\10\Assessmert and Deployment Kt\Windows
< L >

d. If you got to your Deployment share in your D: Drive>Deployment Share>Boot>x86, you
will see you .WIM file now

v | unu — N
me Share View v o Actions
1 « Temporary Storage (D;) » DeploymentShare » Boot v O | Search Boot »p m
Name Date modified Type Size Upd
ccess Clos
x64 4/6/2019 5:56 PM File folder .
op + Viev
x86 4/6/2019 5:53 PM File folder
loads » ~ G Refr
LiteTouchPE_x64 4/6/2019 5:59 PM Disc Image File 376,
t » 2
nems [ LiteTouchPE_x64.wim 4/6/2019 5:59 PM WIM File 3341 = Expt
&s # ¥ LiteTouchPE _x64 4/6/2019 5:59 PM XML Document 5] Proy
£ LiteTouchPE_x86 4/6/2019 5:56 PM Disc Image File 3054 ﬂ Helj
Jsource D LiteTouchPE x86.wim 4/6/2019 5:56 PM WIM File 263,
Jws 10 1SO &) LiteTouchPE x86 4/6/2019 5:56 PM XML Document
op B
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Add Boot Images to WDS

1. Open WDS
a. Server manager>Tools>Windows Deployment Services

! Windows Deployment Services Windows Deployment Services

4 33 Servers
hwlmhldepdcpby.com
h ) Install Images o Windows Deployment Services
b & Bootimages
b i Pending Devices Windows Deployment Services enables you to deploy Windows operating systems over the network.
) ‘ ot Tramiscolisions. MWMMCMM)manmwm(WmMMmW
b & Services. You can perform tasks including adding g server

- images,
b [ Active Directory Prestaged Devices propcha.'wtm.kcmwmmwngmmmltmu\dmmd Fotmm-dmprusﬂ

To manage a server from this snap-in, you must add it first. To add a serves, right-click the Servers node, and then
click Add 3

b. Right Click Boot Images>Add Boot Image

= WINGOWS UEPIOYITIENt JETVICes L=
File Action View Help
2(m & Ber
§ Windows Deployment Services Boot Images t Imag
4 0 Servers ImageName  Architecture  Status Sze Daste  OSVesion P
4 D w20122dep deploy.com o Expanded ocy
p 0 Install Images There are no items to show in this view.
b 4 Bootl
b 1 Pending Devices
b & Multicast Transmissions tmage Fle
b 4 Drivers
b _m Active Directory Prestaged Devices o

Enter the location of the Windows image file that contains the images 1o add.

Flle location:

[ | [ orowse |
b

Note: The defauk boct and install images (Boot wim and Install wim) are located on the

installation DVD in the \Sources folder.

More rfommation about images and mage tvpes
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Find the WIM file under D: Drive>Deployment Share>Boot>x86

- fl‘,«NNVM—DDWI.

v 01 l Search DeploymentShare

A |

Organize ¥  New folder

-~

Il Desktop
8 Downloads
. Recent places

1™ This PC
I Desktop
| Documents
8 Downloads
¥ Music
& Pictures
B Videos
e Local Disk (C:)
. New Volume (D2)

v(l

File name: |

Name

J. SOEMS

L. Applications

J. Backup

b

& C

4 Control

. Operating Systems
4. Out-of-Box Drivers
4 Packages

4 Seripts

4 Servicing

4 _Templates

Date modified

10/17/72015 6:47 PM
1071772015 647 PM
10/17/2015 &48 PM
10/17/2015 7:08 PM
10/17/2015 6:47 PM
10/17/2015 &52 PM
1071772015 647 PM
10/17/2015 6:47 PM
10/17/2015 647 PM
10/17/72015 &47 PM
10/17/2015 &53 PM
10/17/2015 6:47 PM

=<0 e

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder

>

v| |Windows image fies ("wim) v |

| Open

Cancel

Deploy the Windows 10 Image

1. Verify Configuration Settings in WDS
Right Click on your Deployment share, click Properties, then go to sharing

a.

New Volume (D)
Share View
ca » ThisPC » New Volume (0:) v & [[searchNewv:
Name b Date modified Type Sae
s
13 & 50
e . Generd Previous Versions | Customze
& W2012R2Source
bovinttsouce ||| | P [ormerisw ,
e Tive Pl fokder
" Locaton: [ AN
Sae 4.96 GB (5.330.527.506 bytes)
Sceondsk  496GB (5335687163 bytes)
S Cortans:  2.404 Fles. 399 Foldens
me (D)
Crested  Saturday, October 17. 2015, 64721 PM
Aerbutes (8] Readonly (Only spples to fies in folder)
[y [)rdden [ Advanced ]
n selected
[ox ] ooy | [l




C.

b. Go to Advanced Sharing

control:

Genersl  Shamg | Securty | Previous Versions | G

Network File and Folder Shamng
Deployment Share
Shared

Network Path
\\W2012R2DEP\Depioyment Share$

Advanced Shamg

Set custom permssions, create mutiple shares, and set cther
advanced shanng cptions

BT

PRV TR T

Deploymentshare Properties | X ||

s
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Click on permissions and make sure you have the correct Administrators with full



s
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d. Right Click on the Server>Click Properties>Click Advanced:

oo 2[m = B
o ———
4 8 Servers Image Name  Architecture
4 b wa0122dep deploy.com e ol e
»_;Inﬁcllmogu 2 Lite Touch .. 164 onl L Maticast | Network | TFTP ]
b &) Boot Images Gnenl | PXE [ A00s [ Box | Gex | OWcP |
b . Pending Devices
b L& Multicast Transmissions % W2012R20EP
= b 4 Drivers
0 Actve Ooactery Prastoged Devicns Computer name 20122880 daioy com
Remcte nstallaton D\Remcteinstal
folder:
Server mode Native (Windows Deployment Services)
MD

e. Authorize the following:

L"‘_IL"ETMJJDAS | Bot | e | DeP
Muticast | Advanced [ Network l TFIP
Domain Controller

(@ Aow Windows Depk t S to dy ally vahd
= domain servers fecommended)

() Windows Deploymert Services should uss the following servers.
Domain controler: Browse
Global catsiog: Erowse

DHCP Authorzation
O%Mh Deployment Servicas sarver in

@ Authorize this Windows Deployment Services server in DHCP

SIS
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End-User Experience

We first want to test out the deployment with our 2 pilot devices. When we boot them up, it will PXE
boot onto the system, and the user will be prompted to press f12 for a network service boot.

a. From there they will be asked to choose the boot image:

Choose an operating system to start:
(Use the arrow keys to highlight your choice, then press ENTER.)

Lite Touch windows PE (x86) >

Lite Touch windows PE (x64)

Loading files...

[ —

: 192.168.10.10, File: \Boot\x86\Images\LiteTouchPE_x86.wim

b. Run the deployment wizard:

) Microsoft Deployment Toolkit ‘3

A

ks

b Run the Deployment Wizard
to install a new Oper(ting System

Exit to Command Prompt




-
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c. Define the deployment share path that you copied when you first configured the
deployment share in MDT

3 Deployment Share

Specify which deployment share to use.
Before this wizard can continue, it will need to know the path of a Deployment Share.

memm:mwra'\w

W

O

[ gak |[ et |[ concer |

d. Add your credentials:

T s |

¥ Credentials

Specify credentials for connecting to network shares.

N UserName:  |administrator ]
. Bassword: |esessnel N |
W
Romain l |+ Required puissinG)

[ gancel|




N
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e. Choose the appropriate settings here based on your environment:

iter Details

corpawonats B compurername
Move Data and Settings

User Data (Restore) Q
Locale and Time 0 O Join a domain.
Capture Image &
BitLocker Domgin to join:
Ready Qrganizational Unit:
User Name:
Easswd: sesssnnnne
Domain: @

@® Join a workgroup.
Workgroup: |workaroup

[ Back |[ met |[ cancel |

f. Move User data and settings:

T Wodos Dt W ——

Move Data and Settings

Iask Sequence

Computer Detads Move data and settings from a previous version of Windows?
Move Data and Settings @® Do not move user data and settings.

User Data (Restore) Install a new operating system without retaining any data or settings from any existing
Locale and Time operating systems.

Capture image

BitLocker Keep existing partitions (do not format or )

Ready y@

Move uger data and settings.

Capture all the user data and settings from an existing operating system on the computer
and restore them into the new operating system.




= BitLocker
m Specify the BitLocker configuration.
Move Dats and Settings BitLocker can be enabled to provide an additional level of data security for this computer.
User Data (Restore)
Locale and Time ® Do not enable BitLocker for this computer.
BitLocker O Enable BitLocker.
Ready ® Enable BitLocker using TPM only.
Enable BitLocker using TPM and Pin.
Enable BitLocker using TPM and a startup key. st Avallable V
Enable BitLocker using only an Extemnal Startup Key. eV
Choose where 1o store the Recovery Key.
In Active Directory
® Do not create a recovery key. (Not recommended)
Wait for Bitlocker Encryption to complete on all drives before continuing. @

T-Minus @B
g. Do not capture the image:

.
~ Capture Image

Wm&wm Specify whether to capture an image.

il gl i © Capture an image of this reference computer.

User Data (Restore) Specify the UNC path where the image should be stored and the file name to use.
Locale and Time

Capture Image "‘""”"f —

BitLocker = =

Ready File name:

O Sysprep this computer.
Initiate Sysprep for the operating system, not capture an image (useful when
generating a VHD).

O Prepare to capture the machine.
Copy the needed Sysprep files to the proper location, but do nothing else.

® Do not capture an image of this computer.
This is a normal deployment, 5o an image does not need to be captured.

[ gacx ][ mea ][ concel ]

h. Choose whether or not to enable BitLocker

[ gack |[ Met |[ goncel |
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Copy the details that you created. We will be using these for our broad deployment so

end-users do not have to configure all of the info

BROAD DEPLOYMENT:

W

OSDComputerName = “MININT-7LTHKNA"

DomainAdmin = *administrator*

D i 55

DomainAdminDomain = “deploy”

JoINWOrkgroup = “WORKGROUP"

USMTOffineMigration = “FALSE"

UserDatalocation = “NONE™

UlLanguage = “en-us"

UserLocale = “en-us®

KeyboardLocale = “en-us;0409:00000409"

TimeZoneName = *Central Standard Time"
= "NO*

BdeinstallSuppress = “YES®

Iask Sequence <

Comeuter Detall Ready to begin.

Move Data and Settings Using the information you provided, the deployment can now begin.
User Data (Restore)

Locale and Time & Detalls

e TSGuid = "Win10Dep"

Bitlocker DeploymentType = “NWCOMPUTER"

Ready OSDDiskPartitionStyle = "WINIOADVANCED"

b

[ gack |[ segn |[ concel |

j. Back in the Deployment workbench, right-click on your deployment
share>Properties>Rules>Edit Bootstrap.ini

File Action View Help

sz @

ﬁ DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D:\DeploymentShare)]

ﬁ Deployment Workbench

> L2} Information Center

v LA Deployment Shares
v (A MDT Deploy

¢

> [ Applications

> |1 Operating Systems

> [i& Out-of-Box Drivers

> Lk Packages

> L3 Task Sequences

> [ Advanced Configuration
> m Monitoring

nt Share (D:\Deploy

s

MDT Deployment Share (D:\DeploymentShare) Properties

General Rules  Windows PE Monitoring
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k. Paste in your configuration we copied in step “n” under {Default]

] Bootstrap - Notepad

1File Edit Format View Help
|[Settings]
Priority=Default

[Default] ’

L. Update the deployment share to add this configuration

a DeploymentWorkbench - [Deployment Workbench\Deployment Shares\MDT Deployment Share (D
File Action View Help

L ARSIRESN 7

ﬁ Deployment Workbench
> .} Information Center
v [ Deployment Shares
v | MDT Deployment Share (™'~ °

Name

% Applications
- mOperating Systems

> [% Applications Deployment Share
» [, Operating Systems Close Deployment Share
> [k Out-of-Box Drivers
Vi > i
> L Packages i ttion

> L3 Task Sequences Refresh
> [ Advanced Configura

Export List...
> l:] Monitoring

Properties

Help



s
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m. When you are ready for broad deployment, go back to WDS>Right-click on
your server>Properties>Boot>And click Continue the PXE Boot:

! Windows Deployment Services

File Action
s ol A1 (RERESN 7 Bo:

View Help

* Windows Deployment Services
v 3 Servers
v I MDTTesting.wrajrecords.com
» | Install Images
> [+ BootImages
> [ Pending Devices
> (3% Multicast Transmissions
4 Drivers
& Active Directory Prestaged Device

MDTTESTING Properties X
Multicast Advanced Network TFTP
General PXE Response AD DS Boot Client DHCP

PXE Boot Policy
After a network boot is initiated, define when a PXE boot will continue.
Known clients:

(O Require the user ss the F12 key to continue the PXE boot
O Aways conti e PXE boot

(® Continue the PXE boot unless the Tgr presses the ESC key

(O Never continue the PXE boot

Unknown clients:

(® Require the user to press the F12 key to continue the PXE boot
O Aways continue the PXE boot

(O Continue the PXE boot unless the user presses the ESC key
(O Never continue the PXE boot

n. With these settings configured, all of the users in your environment will get
the image pushed to them without having to press f12 or run through the
wizard of setting like we did for out pilot users
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Conclusion

| hope this article provided you some targeted guidance on deploying the Windows 10 upgrade across
your network. Any feedback to improve your experience would be greatly appreciated. | would also like
to hear if there is more content that you would like to see in this guide. Any feedback can be sent to my

email below:

Msp4dmsps@tminus365.com
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